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1. Introduction
1.1 About This Guide

TDK SensEl's edgeRX™ end-to-end platform is a complete solution for real-time equipment
health monitoring. The edgeRX™ solution leverages edge Al to process data locally at the
source for faster, more accurate, and more efficient insights. edgeRX™ is a user-friendly, low-
maintenance solution that optimizes the collection, analysis, and management of machine
health data. By continuously monitoring the health status of critical assets, edgeRX™ reduces
unexpected downtime, optimizes maintenance to improve efficiency and effectiveness, and
enables predictive maintenance for users.

This guide provides a comprehensive step-by-step approach to using the edgeRX™ Platform for
monitoring machine performance. By leveraging real-time data visualization on the platform,
factory operators can proactively address maintenance needs, reducing downtime and
operational costs.

1.2 Related Documentation

For hardware setup, installation, and physical device troubleshooting, please refer to the
following user manuals:

Document Model Number Contents

edgeRX™ Gateway SE5100204G-01 Gatgway hardware.se’fup, power cqnnectlon, network
User Manual configuration, LED indicators, physical troubleshooting
edgeRX™ Lynq Sensor hardware activation, physical installation, battery

SE1111101G-01

Sensor User Manual information, LED indicators, physical troubleshooting

These documents can be obtained from your local TDK SensEl representative.
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2. Getting Started
2.1 Logging into Your Account

Follow these steps to log into your account:

2.1.1 First-Time Login (New Users)

1. Open the welcome email received from the tdksensei.com domain.
2. Click the login link to access the edgeRX™ Platform.

3. Create your password during the first login.

4. Complete the MFA setup process (see Section 2.1.2).

&TDK

Create Password
Create a new password for your account

New Password

Confirm Password

Need help? Reach out to Support

Edge@ by TOK SensEl

Figure 1: Create Password Page
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2.1.2 MFA / Authenticator Setup

Multi-Factor Authentication (MFA) adds an extra layer of security to your account.

1. After entering your credentials, you will be prompted to set up MFA.

2. Download an authenticator app on your mobile device (e.g., Google Authenticator,
Microsoft Authenticator).

3. Scanthe QR code displayed on screen using your authenticator app.

E P
© step 2 Step2
Setup Authenticator App

Scan the QR code with your authenticator app

Continue with Authentication

edge@ by TOK Sensl

Figure 2: MFA Setup Page

4. Enter the 6-digit verification code generated by your authenticator app.
5. Click "Verify" to complete the setup.



&TDK
TDK SensEI

/\ Trust This Device: You may select the "Trust This Device" checkbox to bypass MFA for

30 days on that specific device.

2.1.3 Existing Users

°S!ep1 — °5tep2

Authentication Code

Please enter the authentication code sent to
your authenticator app.

ck to Setup

Edge@ by TDK SensEl

Figure 3: Authentication Code Entry

1. Navigate to the edgeRX™ Platform login page.
Enter your registered email address and password.

3. Enterthe 6-digit code from your authenticator app (if MFA is enabled and device is not

trusted).

4. Click "Login" to access the Platform.

1]

Login

Enter your account credentials to login

Username or Email
Password

Forgot Password

Don't have an account? Reach out to Support

edge@ by TDK SensEl

Figure 4: Login Page
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2.1.4 Forgot Password

If you have forgotten your password:

Login

Enter your account credentials to login

Username or Email

Password

Forgot Password

Don't have an account? Reach out to Support

edge@ by TDK SensEl

Figure 5: Forgot Password Highlighted

Click the "Forgot Password" link on the login page.

Enter your registered email address.

Click "Submit" to receive a password reset link via email.
Open the email and click the reset link.

Enter and confirm your new password.

Click "Reset Password" to complete the process.

Return to the login page and sign in with your new credentials.

NoOoOasrON=

i

Reset Password
Create a new password for your account

New Password

Confirm Password

Need help? Reach out to Support

edge@ by TOK Sensel

Figure 6: Password Reset Flow

10
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2.1.5 Profile Settings

Users can manage their personal account settings by clicking the user icon located at the
bottom-left corner and navigating to "Profile Settings".

Profile Settings

Change Password
Current Password
[ Edit profile ‘

- . N P d
Ekin-admin lew Passwor

smm— | =

Job Title

Al Facility HE EN H (¢ ‘ o

Confirm New Passward
Department

| @
Temperature Preference

‘ 3 Fahrenheit ¢F password change is successful, you will be logged ou

Trusted Devices

() Device Name Last Login Trusted On Expires On Actions

[} Windows - Microsoft Edge 03 Mar 2026, 05:34 PM 03 Mar 2026 02 Apr 2026 ‘ o) ‘

(] Windows - Microsoft Edge 03 Mar 2026, 12:59 PM 03 Mar 2026 02 Apr 2026 ‘ o) ‘

O ‘Windows - Not:A-Brand 26 Feb 2026, 09:34 PM

23 Feb 2026 25 Mar 2026 ‘ o] ‘

Figure 7: Profile Page
From here, users can:
o Edit personal profile details — Update your name and contact information.

e Change password — Update your account password.

e Manage trusted devices - View and remove devices that have been trusted for MFA
bypass.

11
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2.2 Navigating the Platform's Homepage

After logging in, you will be directed to the Platform's Homepage. Here you'll see an overview
of real-time information:

&TDK

[l  Dashboard
TDK SensEl

All Facility || = en

MAIN MENU & %
b Welcome, Ekin-admin!

08 Dashboard B tonitor your IoT devic

User Logs

Trend Analysis

@ Assets

Alarms g Warnings iy Recent Alerts View All
A Sensors
)  Gateways
Q Motifications
i Asset Status Distribution Sensor Connectivity Y

Mo MNotification Available
Online Yfline

&  Manage Users 0 Online » Cﬁ Offline =
= Manage Roles Mo Asset available. Please add an asset

to view information
@ Manage Locations Gateway Connectivity =)

N o

& Manage Asset DB 0 . (O or .

8- Overstionsl @4
Q@i
edge@ by TOK sansel
Figure 8: Dashboard Homepage
Widget Description
Alarms Active alarms across connected assets
Warnings Active warnings across connected assets
Sensor Connectivity Sensor connection health
Gateway Connectivity Gateway connection health
Trend Analysis Chart High-level metrics showing asset behaviour over time

12
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2.2.1 Location / Facility Selector
Use the location/facility selector dropdown to switch between different sites or facilities
within your organization.

/\ Note: Access to this dropdown is restricted to Admin and Global Executive users only.

2.2.2 Trend Analysis Chart
The Trend Analysis chart analyses historical trends of notifications using a line chart. Features
include:

e Custom date range picker
e Time adjustment slider

2.2.3 Language Selector

The Global Language Selector is located in the top right corner of the dashboard screen. Users
can switch between the following languages:

e English (default)
e Japanese
e Simplified Chinese
The selected language persists across all pages of the application.

2.2.4 Theme Toggle
The theme toggle is located in the top right corner of the screen. Users can switch between:

e Lighttheme
e Darktheme
The selected theme persists across all pages of the application.

/\ Troubleshooting: If any widget appears inactive or blank, confirm that your gateways and
sensors are online.

13
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3. Managing Users & Permissions

The Administrator ("Admin") can create separate roles and assign specific permissions based
on the organization's requirements. The TDK SensEl team will set up an organization account
on the edgeRX™ Platform and grant access to a designated Administrator user.

3.1 Manage Users

Navigate to Settings > Manage Users to access user management functions.

ﬁ;rsg!f; 1 Manage Users All Facility E EN

MAIN MENU )

08 Dashboard LEpaument ‘_ = & @ ]
B Assets . .
A Sensors

=) Gateways

Q Motifications
SETTINGS

Po Manage Roles

@ Manage Locations

& Manage Asset DB

|D User Logs

Figure 9: Manage Users

3.1.1 Viewing the User List

The user list displays all users within your organization. You can:

o View all registered users

o Filter users by Department using the dropdown in the top left corner

e Search for users using the search bar by username or email ID

o Adjust the number of rows displayed per page using the "Rows per Page" dropdown

3.1.2 Adding a New User
To add a new user:

1. Click the "Add" button on the top right corner.
2. Enter the following details in the modal:
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Add User

User Mame®

Role*

Select Role

Location™

Select Location

Department®

Select Department

Figure 10: Add User Modal

Field Description

User Name Full name of the user

Email User's email address (used for login)

Role Select from existing roles dropdown
Location Select from existing locations dropdown
Department Select from existing departments dropdown

3. Click "Add User" to create the new user account.
4. Click "Cancel" to terminate the action without adding the user.

/\ Note: The new user will receive a welcome email with instructions to set up their
password and MFA.
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3.1.3 Managing Existing Users

For each user in the list, you can

Action Description

Edit User Details

perform the following actions:

When to Use

Update user information including email  User changes role, department, or

address email
Assign Roles Change the user's role and permissions  User responsibilities change
Resend Welcome Send a new welcome email to inactive , o
. User hasn't completed initial setup
Email users
. User forgot password or securit
Reset Password Force password reset for active users gotp y

concern

Resend Verification Send verification email after email

Email address upd

. User's email address was updated

User lost access to authenticator

Reset MFA Clear MFA setup for a user

app

Manage Users

Department

o ekin Administrator

All Facility =

@ Q + Add User [ES

=

=](=](e]

|T| 10/ page

ekin.ngor+a@tdk.com

To perform any of these actions,
next to the user's name.

Figure 11: Members List

click the corresponding icon or button in the Actions column
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3.2 Manage Roles

Navigate to Settings > Manage Roles to create or edit roles and assign module-level access.

&TDK Manage Roles | Al Facility || = | | © ‘ Ja)
TDK SensEl R
MAIN MENU
08 Dashboard Role List
@ Assets Global Executive
A Sensors
@ Gateways Dashboard Page Visibility ()
_ﬂ Motifications
Assets Page Visibility ()
SETTINGS
2 Manage Users = =
Notifications Page Visibilit
@ Manage Locations g Y D
& Manage Asset DB = ] =
@ User Logs
Gateways Page Visibility ()
&) 2
Sensors Page Visibility ()
(%]
(%]
Settings Page Visibility ()
= = = &
=]

Ekin-admin
@t e
Administrator

Figure 12: Manage Roles

3.2.1 Adding a New Role

To add a new role:

Click the "Add" button.

Enter the role name in the field.

Click "Create" to add the new role.
Click "Cancel" to terminate the action.

o=

Add Role %

Role Mame

Viewer ‘

| Cancel | Create

Figure 13: Add Role Viewer
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3.2.2 Configuring Role Permissions
Use the toggle buttons and checkboxes to enable or disable permissions for each role:
o Toggle buttons control module access (e.g., Sensors, Gateways, Assets,

Notifications)
e Checkboxes control specific actions within modules (e.g., View, Add, Edit, Delete)

Role List
Administrator Global Executive + Add
Dashboard Page Visibility D
Assets Page Visibility ()
[] Add / Edit / Delete asset e Add / Replace / Unbind / Edit

~ sensor

Notifications Page Visibility ()
] Ack! Delete asset event () Ack{ Delete sensor event () Notification setting
Gateways Page Visibility ()
[C) Add/ Edit / Delete gateway [J Gateway reboot
Sensors Page Visibility ()
e Add / Edit / Delete sensor [ conf g sensor node
— node
Settings Page Visibility ,_)

Figure 14: Role Permissions

Click "Save" to apply permission changes across all users assigned to that role.

3.3 Global Executive Role

The Global Executive role provides special privileges:
o Read-only access to every location in the organization
o Ability to switch between locations using the location selector
e View all platform data including:
e Sensors
Gateways
Notifications
Insights
Home KPIs
Data displayed is based on the currently selected location.

/\ Note: Global Executives cannot modify data or settings, only view them.
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3.4 Profile Settings
Every user has access to their own account management options via Profile Settings. For
detailed instructions, see Section 2.1.5.

3.5 Adding a Department

To add a new department:
1. Click the Department dropdown.
2. Enter the department name in the field.
3. Click "+" to create the new department.

E EN

STDK Manage Users All Facility ||

TDK SensEl

MAIM MENU
Department H -1 Q | + Add User | & ‘

08 Dashboard

B Department Email Actions I'" ..ﬁ[

Ar Sensors

Figure 15: Adding a Department

19



4. Gateway Management

4.1 Adding a Gateway to the Platform

/\ Note: Before we can add a gateway, we must set up a location, refer to 11.1 Location

Hierarchy to set up a location.

Log into the edgeRX™ Platform using your authorized credentials, then navigate to Gateway

Summary page.

&TDK
TDK SensEI

&TDK

Gateways
TDK SensEl

MAIN MENU

| All Facility

||E H;i

:|;3

E EN

08 Dashboard |

a

a

@ Assets

Ar Sensors

=) Gateways .

Q Motifications

Number

Location

Last Seen

SETTINGS

2 Manage Users

Po Manage Roles

@ Manage Locations

& Manage Asset DB

User Logs
(8] g

Steps to Add a Gateway

Figure 16: Gateway Summary

1. Navigate to Gateway > Add Gateway.

Add GW2201D 2.0

Gateway [D*

Mame*

Location™®

| Select Location

2. Enterthe required details:

Figure 17: Add Gateway Modal
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Field Description
Gateway Name A custom name for identification

The 12-character Gateway ID (found on the Gateway's box or on the

Gateway ID
v flat-bottom surface of the Gateway)
Location Select the location of the Gateway on the floorplan
Add GW2201D 2.0 =
Gateway ID* MName*
. 34dacib10111 -. ."EG_L:I:I

Location™®

Singapore-ATS / lab / level16

Coordinate X (Meter)* Coordinate ¥ {Meter)*

10.76 | | 656

@ Please click on the map to select a location

sl 1 | +]

Figure 18: Add Gateway Details

3. Plot the coordinates on the map component.
4. Click "Save" to register the Gateway into the system.
The new Gateway will appear in the table and be available for monitoring and management.

/\ Note: Ensure that your edgeRX™ Gateway is online and connected using the Detail tab. If
your edgeRX™ Gateway appears offline, see Section 12 for troubleshooting steps. For physical
sensor installation instructions, refer to the edgeRX™ Gateway User Manual.
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4.2 Managing Gateways

4.2.1 Reboot a Gateway
1. Click the "Reboot" button.
2. Click "Confirm" to reboot the Gateway.
3. Clicking "Cancel" will terminate the reboot action.

/\ Note: Users can only reboot one Gateway at a time.

4.2.2 Delete a Gateway
1. Click the "Delete" icon.
2. Click "Delete" to remove the Gateway.
3. Clicking "Cancel" will terminate the delete action.

4.2.3 Edit a Gateway
1. Click the "Edit" button from the actions column.
2. Update the Gateway ID, Name, and/or Location fields.
3. Click "Save" to ensure your changes are saved.
4. Clicking "Cancel" will terminate the edit action.

4.3 Gateway Table Features

The table provides a searchable, paginated view of all Gateway devices.

Feature Description
Search Bar Locate Gateways by Name, Gateway ID, or Version
Rows per Page Adjust the number of rows displayed (dropdown in bottom right corner)
Column Settings Customize visible columns (Settings icon on top right corner)
Gateways E .

5G_lab1 34dacib1011c v0.0.1 5 = Offline Singapore-AT5/la... 2026-02-19 16:40:25 ‘ o] |

5G_lab2 213da239af8c # Offline Singapore-AT5/la... ‘ _ﬂ |

|I| 10/ page

Figure 19: Gateway Table
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4.4 Gateway Detail View

To access detailed information about a Gateway, click on the Gateway ID from the listing. This

opens the Gateway Detail View with multiple tabs:

€ Gateways

presidio-gw-2

B Dpetails

Gateway Information

presidio-gw-2 34dac1b10038 559

Facility-F2/Building-F2/Floor-F2 2026-01-05 21:37:45 35% / 20%

i
TT

R

1

All Facility

Figure 20: Gateway Detail View

4.4.1 Detail Tab

Displays the following information:
¢ Name
e GatewayID
¢ Online/Offline Status
e Firmware Version
¢ Number of Connected Sensors
e Location
e LastSeen Timestamp
e Real-time CPU and RAM usage

4.4.2 Sensor Tab

Allows you to:
¢ View sensors currently connected to the Gateway
e Add/delete sensors

e Click on a Sensor ID to view sensor details (see Section 5)
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B peie @ Dlanestic ‘ o e
Sensor List + Add sensar ‘(w)‘

Sensor 1D Sensor Type Associated Asset Firmware Version  RSSI Last Seen on Status Action
340ac1200909 Lynq lab_motor 1105 -47dBm 2026-02-06 14:53:04 “Offine ‘E|
34dac1200a23 Lyng lab_motor 1.105 -39dBm 2026-02-03 14:36:53 *Dffline ‘E|
4dac120018a Lynq I3 motor 1105 -40dBm 2026-02-03 14:36:14 = Offline ‘E|
34dac1200b94 Lyng lab_motor 1.105 -21dBm 2026-01-14 09:52:54 *Otfline ‘E|
34dac1200860 Lyng I3 motor 1105 35dBm 2026-01-14 09:52:46 = Offline ‘E|

[0 Lo |

Figure 21: Attached Sensors

4.4.3 Diagnostics Tab
Monitor the health and performance of the Gateway over time:
CPU and RAM Usage Graph

o Toggle between predefined time ranges: 1 Day, 3 Days, 1 Week
o Alternatively, use the custom date range picker

€ Gateways Al Facility =
presidio-gw-2 3 Reboot
o ) > . o
System Performance
¢ 3Days | 1Week | 2026-01-04 20260105
- -2
100
%
0%
a0
20% T
o
' |

Figure 22: Ram and CPU Chart
Received Packets Statistics Graph

o Analyze network traffic patterns
o Toggle between predefined time ranges: 1 Day, 3 Days, 1 Week
o Alternatively, use the custom date range picker
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Packets Statistics e’ | 1wedic | Fstasiios I

Figure 23: Packet Statistics

4.4.4 Logs Tab

View the Gateway's behaviour and operational history:
e Lastfirmware update date with user details
e Eventdetails including:
e Online/offline status changes
e Reboots
e Sensor assignments
e Location changes

B Details & Sensors &8 Diagnostics

Item Event User Updated On

1 Gateway is offline! admin 2026-02-13 16:44:05
2 cpu alarm - 2026-02-13 16:37:05
3 Gateway is online - 2026-02-19 16:36:22
4 Gateway is offline! admin 2026-02-19 15:14:05
S bind a cn2202b 3.0{200909) ekin.ngor 2026-02-06 14:52:34
6 unbind a cn2202b 3.0({123456) ekin.ngor 2026-02-06 14:52:00
7 bind a cn2202b 3.0{123456) ekin.ngor 2026-02-06 14:48:32
8 unbind a cn2202b 3.0{200909) ekin.ngor 2026-02-06 14:47:41
9 bind a cn2202b 3.0{200909) ekin.ngor 2026-02-06 14:35:23
10 unbind a cn2202b 3.0{123456) ekin.ngor 2026-02-06 14:39:11

2 3 4 > | 10/ page |

Figure 24: Gateway Logs
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5. Sensor Management

5.1 Adding a Sensor to the Platform

/\ Note: You can add up to 10 sensors to a single gateway.

Log into the edgeRX™ Platform using your authorized credentials, then navigate to Sensor
Summary to view all registered sensors in a paginated table.

8TDK Tl  Sensors | All Facility ‘ | E N

TDK SensEl

MAIN MENL

|= rocess q onfigure | e & Export | |
98 Dashboard | Q | = Process ‘L}eue| ‘ 1 Expor | .(éj
@ Assets

AR SensorID . Name - Type Gateway ID - Status - Power & Asset & Last Seen on

@) Gateways

Q Maotifications

Figure 25: Sensor Summary

Steps to Add a Sensor

1. Goto Sensor > Add Sensor.

Add Sensor *%

Sensor Type™

Select Sensor Type

Sensor [D*

Mame*

Gateway™

Select Gateway |

Figure 26: Add Sensor Modal

2. Enterthe required details:
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Field Description

Sensor Name A custom name for the sensor

Sensor ID The Sensor ID (found printed on the side of each sensor)
Gateway Select the appropriate Gateway from the dropdown
Location Assign the sensor to a mapped location

3. Click "Add" to register the sensor into the system.
The new sensor will appear in the table and be available for monitoring and configuration.

/\ Note: For physical sensor installation instructions, refer to the edgeRX™ LYNQ
Sensor User Manual.

5.2 Managing Sensors

5.2.1 Edit a Sensor

Navigate to the sensor listing.

Click the "Edit" icon from the actions column.
Update the Sensor Name and/or Gateway details.
Click "Confirm" to save the edited changes.
Clicking "Cancel" will terminate the edit action.

oo

Edit Lynq X

Sensor Type®

Sensor ID*

Mame™*

Position_Shaft

Gateway™

5G_lab1 (34dac1b1011c)

Figure 27: Edit Sensor

27



&TDK
TDK SensEI

5.2.2 Delete a Sensor

1. Click the "Delete" icon from the actions column.
2. Click "Confirm" to delete the sensor.
3. Clicking "Cancel" will terminate the delete action.

Delete Sensor ¢

Are you sure you want to delete the sensor 34dacla21c3f?

o

Figure 28: Delete Sensor Modal

The sensor will be removed from the table and no longer available for monitoring.
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5.3 Sensor Table Features

The Sensor table provides a searchable, paginated view of all Sensors.

Sensors ‘ H E N | |:| Al
Q | | % Process queue ‘Txlt| |£‘
O 34daci200909  Positon.Sh..  Lyng — womrd  2sv lbmotor 20260206 145304 1108 ‘E|
O 34dac1200a23 lab_mator_1 Lyng 34dacib1011c = Offline 3V lab_motor 2026-02-03 14:36:53 1.105 ‘E|
O 1200188 Labmetor3  Lyng 3acactbi0ne w3y lbmetor 20260203 143614 1105 \E|
O 34dsci200094  labmotor2  Lyng 3adactbianic W 2o0v labmotor 0260114095254 1.105 ‘E|
O 34021200860  labmotor 4 Lyng 34cactbi0tc ) v hbmewr  20%60114085246 1105 \E|
=) [
Figure 29: Sensor Table
Feature Description
Search Bar Locate sensors by Name or Sensor ID
Rows per Page Adjust display (dropdown in right bottom corner)
Column Settings Customize visible columns (Settings gear in top-right corner)

Table Columns:
e SensorlID
e Sensor Name
e Sensor Type
e Linked Gateway
¢ Online/offline status
o Battery Life
e Linked Asset
e LastSeenTime
e Firmware version
o Delete and Edit actions
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5.4 Sensor Configuration

5.4.1 Process Queue

The "Process Queue" button (on the top panel) enables you to view current and pending OTA
& Configuration updates to the sensors.

Process Queue »

Clear History

OTA Configure
No. Sensor ID Sensor Type Status Created On Upgrade On
1 34dac120018a Lyng ® Finished 2026-01-13 14:32:02 2026-01-13 14:38:34

|3 | 10/ page

Figure 30: Process Queue Modal

5.4.2 Configure KPI Interval

1. Select one Sensor from the listing screen.

2. Click the "Configure" button on the top panel.
3. Inputyour desired KPI Interval.

4. Click "Save" to apply changes.

Sensors | H E N (CHIFAN
Q | ‘ = Process gueue | ‘ £ Configure | + Add ‘ &, Export | | @ |
Sensor ID Name Type Gateway [D Status Power Asset Last Seen on Version Actions

u 34dac1200909 Position_Sh... Lyng 34dac1b1011c | # Offline | 29V lab_motor 2026-02-06 14:53:04 1.105
34dac1200a23 lab_motor_1 Lyng 34dac1b1011c |m| 3V lab_motor 2026-02-03 14:36:53 1.105
34dac120018a Lab_motor_3 Lyng 34dac1b1011c | = Offline | 3V lab_motor 2026-02-03 14:36:14 1.105
34dac! 200b94 lab_motor_2 Lynq 34dacib1Di1c "= offine | 29V lab_motor 2026-01-14 09:52:54 1.105

34dac1 200860 lab_motor_4 Lyng 34dac1b1011c | * Offline | EXY lab_motor 2026-01-14 09:52:46 1.105
0 [

Figure 31: Configure Sensor
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Sensor Configuration ¢

KPI Interval™

0 Haours 10 Mins

Sensor List
Itermn Sensor ID MName Sensor Type KFPI Interval Actions
1 34daci 200909 Position_Shaft Lyng 0 Hours 10 Minutes |mj

E] ‘ 10/ page ‘
o | D

Figure 32: Configuration Modal

5.5 Sensor Detail View

Click on a sensor from the listing to open its Sensor Detail View. This page includes
configuration settings, performance metrics, and Al insights.

€ Sensor | ] ||ss:u

&

Lyng | 34dac1200909

B overview I Machine Learning Insights [3 Data Record ‘ £ Live View ‘ ¥ Diagnostics ‘ &) History

shaft el Specifications #Z Sensor Data
ensor Typ Sensor ID on ® M 7 dem
Lyng 34dac1200909  1.105 20y
ODR FSR ateway i Latency ; Skin Temperature
il ]
BK Hz +2q 5G_lab1 05155
KPI Inte R Data Interval m RIS (X m
10 mins 10 mins
e E
Asset Details
\sset Type sset Mode Asset Name Location (I
Motor Qw-10 lab_motor Singapore-ATS / lab / level16

Figure 33: Sensor Detail View
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5.5.1 Overview Tab

Displays the following information:

Visual Sensor Placement
 Shows where the sensor is mounted

Asset Details

Bind asset to view asset information

Installation Sensor Axis

Bind asset to view installation diagram

Vertical

X axis: Vertical ¥ axis: Horizantal Z axis: Axial

Figure 34: Bind Sensor Visual Guide

/\ Note: Installation diagram will only show up after binding sensor to an asset.

Connectivity and Signal Status

shaft % @

Figure 35: Connectivity indicators

Sensor Specifications:
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e Output Data Rate (ODR)
e Full-Scale Range (FSR)
e KPlInterval

¢ Raw Data Interval

¢ Inference Interval

e Network
Specifications #
Sensor Typ: Senzor D Version
Lyng 34dac1200909 1.105
ODR FSR Gateway
BK Hz +2q SG_lab1
KPI1 | ra
10 mins 10 mins

Figure 36: Sensor Specifications

ML Information:
e ML Modelinuse
e MLType
e Class Label
e Score Threshold
e Class Alarm/Warning

ETDK D 4 Sensors All Facility

TDK SensEl

in

MAD et 34dac12004be

98 Dashboard

e I Machine Learning Insights Data Reco & Live View
ssets

(o) Gateways

L Notifications Inference Results

SETTINGS
Class Probabilities

A Manage Users

Class Labels Probability

cluster 0

S0 Manage Roles

cluster 0 1.00
® Manage Locations A
Anomaly Score at 2025-12-30 23:45:31: 0.09

& Manage Asset DB

sam > Real-time Anomaly Scores
Administrator =

gdgg@ —

Figure 37: Machine Learning Page

Sensor Data:
e Battery Voltage
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e RSSI
e Latency
e Skin Temperature
e VRMS(X,Y,2)
e ML Classification
Sensor Data
Battery Information RSSI
@ e il
29V -47 dBm
I Latency Skin Temperature
! 05155
e VRMS®) g VRMSO
-||||' VRMS (Z)
Figure 38: Sensor Data
Asset Details:
e AssetType
e Asset Model
e AssetName
e Location
Asset Details
Asset Type Asset Model Asset Name Location [T
Motor QW-10 lab_motor Singapore-ATS / lab /

5.5.2 Diagnostics Tab

levell6

Figure 39: Asset Details

Select a time range to view historical data including:
Battery Voltage
RSSI (Signal Strength)
Packet Statistics

Latency
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Battery Voltage

2026-02-02 - 2026-03-04 [4

‘ 1 Week IIIl:HH!I 3 Months ‘ 2026-02-02 2026-03-04

—@- Battery Voltage

33

3.2

w

T T T T T T T T T THCNT T KT M 1

R S S S S N B S S S ——R—— 2.8V

2.6

5 T T
2026-02-03 17:35:47 2026-02-03 20:00:00

T T T T T 1
2026-02-03 22:00:00 2026-02-04 00:00:00 2026-02-04 02:00:00 2026-02-04 03:42:

Figure 40: Battery Voltage

RSSI

2026-02-02

‘ 1 Week II!I’HHI 3 Months ‘ 2026-02-02 2026-03-04

—@- RSS!

T T T T 1
2026-02-02 17:18:04 2026-02-02 19:00:00 2026-02-02 20:00:00 2026-02-02 21:00:00 2026-02-02 22:00:00 2026-02-02 23:35:

Figure 41: RSSI Graph

&TDK

TDK SensEI

35



ETDK

TDK SensEI

Packet Statistics

2026-02-02 - 2026-02-02 [4

1 Week 1 Month 3 Months 2026-02-02 - 2026-02-02

—@— KPI Packets —@- Raw Data Packets

0.8

0.6

0.2

0

T T T T T T T 1
026-02-02 13:54:.04 2026-02-02 16:00:00 2026-02-02 18:00:00 2026-02-02 20:00:00 2026-02-02 22:00:00 2026-02-02 23:54:

Figure 42: Packet Statistics

Latency

1 Week 1 Month 3 Months 2026-02-02 2026-02-02

—@- Latency

1200

1000

/00

600

400

200

O T T
2026-02-02 13:45:06 2026-02-02 16:00:00

J T T T 1
2026-02-02 18:00:00 2026-02-02 20:00:00 2026-02-02 22:00:00 2026-02-02 23:59:

Figure 43: Latency
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5.5.3 Event Log Tab
View a chronological record of system and model-related events, including:
e Configuration changes
e Model deployments
e Sensor status changes
e Sensorresets
e Cluster/class label renaming
e Firmware updates
e Interval changes
e Changes in associations with assets, Gateways, or networks

Lyng | 34dac1200a23

E overview ‘ Il Machine Learning Insights [3 Data Record £ Live View & Diagnostics 8) History

Activity Logs
Item Asset Name Asset Type Install time Remove time
1 lab_motor Motor 2026-01-13 14:25:35
2 YTC-PUMP1-UAT Pump 2025-12-26 23:58:11 2026-01-13 14:23:13
EJ ‘- 10/ page

Figure 44: Sensor Event

5.5.4 Sensor History Tab

View installation and removal records associated with the sensor or system.

Lyng | 34dac1200a23

B Overview ‘ [N Machine Learning Insights [® Data Record I Live View # Diagnostics &) History

Activity Logs
Item Event User Updated On
1 €n2202b 3.0 is offline! - 2026-02-03 14:54:05

update Change parameter "Live view:Data source” from no selection to Axial/Radial_V/Ra
2 Change parameter "Live view:ODR" from 0kHz to 1kHz Karan.Shetti 2026-02-02 13:45:45
Change parameter "Live view:FSR":no selection to 2

3 €n2202b 3.0 is online - 2026-02-02 13:44:56
4 €n2202b 3.0 is offline! - 2026-01-14 09:56:05
5 n2202b 3.0 is online - 2026-01-13 14:53:31
6 €n2202b 3.0 is offline! - 2026-01-13 14:48:05
7 Change parameter "Name” from Shaft-end to lab_motor_1 Karan Shetti 2026-01-13 14:25:.02
8 €n2202b 3.0 is online - 2025-12-22 17:01:50
9 add cn2202b 3.0 sensorlD:200a23 bind to gatewaylD:34dacib1011c Karan.Shetti 2025-12-22 17:00:27

() [

Figure 45: Sensor History
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6. Asset Management
6.1 Adding Assets

/\ Note: To set up assets on the edgeRX™ Platform, users must

1. have created a department (see Section 3.5).
2. addan asset model in the AssetDB section (see Section 11.2.2) or add a model during

asset creation.

Log into the edgeRX™ Platform using your authorized credentials, then navigate to Assets
Page to view all registered assets in a searchable, paginated table.

STDK ([l  Assets

TDK SensEl

MAIN MENL!

Last updated: Mar 3, 2026, 5:34 PM ‘ All Facility | ‘ E EN | | & | Al

08 Dashboard |

o | e

Asset Name

Ar  Sensors

Asset Type

(@) Gateways

Sensor{s} Status - Updated on - Sensor Values

Q Maotifications

Steps to Add a New Asset

1. Goto Assets > Add Asset.

Figure 46: Asset Table

Add Asset

Asset Name*

Department®

Select Department

Asset Type* Criticality*

Add asset image

Select Asset Type |

Select Criticality ‘

Asset Model*

‘ Select Asset Type first

Facility™

Select Facility

4 EEEEEEEEEE——— v

‘ Cancel H |

2. Enterthe required details:

Figure 47: Add Asset Model
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Field

Asset Name
Department
Asset Type
Criticality
Asset Model
Image

Facility

Description

Custom name for identification

Select from pre-selected list

Select from predefined types

Select criticality level (High, Medium, Low)
Choose an existing model or create a new one
Upload an image of the asset

Assign the asset to a mapped facility or zone

Add Asset

Asset Name*

| ]

Lab Motor

Department*

Engineering

Asset Type*

Criticality* Add asset image

‘ Maotor

‘ ‘ High ‘

Asset Madel®

Rotate speed (RPM)

Power (kW)

‘ G600

| | 300 |

DE bearing®

Line Frequency (Hz)

N206

Mum of poles

Voltage (V)

Current [A)

Facility*

‘ Ekin Lab ¥ Building ¢ Floor ‘

4

v
»

‘ Cancel

Figure 48: Creating New Asset Model

3. Click "Add" to register the asset into the system.

The new asset will appear in the table and be available for monitoring and configuration.

&TDK
TDK SensEI
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) Gateways
g Notifications

SETTINGS

S o

&TDK [J  Assets st L Mar 3, 2026, 5:34 PM | Al Facility | ‘ =43 | | © ‘ o
TDK SensEl ’
MAIN MENU
+ add RN
88 Dashboard ‘ Q | - B
Asset Name Asset Type Sensor(s Status Updated on l'_ . Location
A Sensors '

8 o A Ekin
Lab Motor Matar ] # Operational 2026-03-03 19:06:17 A High
Lab/Bullding/Floor

| 1 ‘ | 10 / page

Figure 49: Asset Table

6.2 Asset Table Features

Feature Description

Search Bar Locate assets by name, ID, or keyword
Column Settings Show or hide specific fields

Rows per Page Adjust display (dropdown in right bottom)

Table Columns:
e AssetName
e AssetType

e Linked/Associated Sensor(s)

e Status

e LastUpdated Time
e Sensor Values
e Criticality (High, Medium, Low)

e Location
e Actions
6.3 Managing Assets

6.3.1 Delete an Asset
1. Click the "Delete" icon from the Actions column.
2. Click "Delete" in the modal that appears to confirm.
3. Clicking "Cancel" will cancel the delete action.

Delete Asset

Are you sure you want to delete asset Lab Motor?

| o | m

Figure 50: Delete Asset Model

Upon confirmation, the asset will be removed from the system.
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6.4 Binding Sensors to Assets

To bind a sensor to an asset:

1. Click on an Asset Name to open the Asset Detail View.

&TDK
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< Assets

lab_motor ‘ 1

== ][s]

-+ Bind Sensor

B oOverview & Status ‘ B Event ‘ Log
lab_motor Specifications Alarm Threshold

Asset Name Criticality Skin temperature
lab_motor High .

Warning 40.00°C
Department Asset Model
Test Qw-10 Alarm 50.00°C
Asset Type Rotate speed
Motor 600 RPM ISO standard: 15010816-3/Group
Power DE bearing |/Flexible
300 kW n Warning 7.1mm/s
Line MNum of poles
Frequer Alarm TTmm/s
-Hz
Voltage Current
-V -A

Figure 51: Asset Details

2. Click the "Bind Sensor" button on the top right corner.

3. Enter the following details in the modal:

Field

Sensor Type
Sensor ID
Mounting Position

Orientation

Description

Type of sensor

Select from available sensors

Physical mounting location on the asset

Sensor orientation (X, Y, Z axis)
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Bind Sensor

Sensor Type* Sensor ID (Sensor Name)*

Lyng ‘ ‘ 34dac1200909 (Position_Shaft)
Position* Orientation

shaft ‘ ‘

»

‘ Cancel H

Figure 52: Bind Sensor
4. Click "Add" to bind the sensor to the asset.

Unbinding a Sensor

Click on the Sensor ID of the sensor bound to that asset.
You will be redirected to the Sensors page.

Click the "Unbind" button on the top right corner.

Click "Confirm" to unbind.

Clicking "Cancel" terminates the action.

abrwbd-=

Unbind Sensor X

Are you sure you want to unbind this sensor from the asset?

Figure 53: Unbind sensor
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6.5 Asset Location Management

To update the asset location:

1. Click the "View Map" button to open the interactive map.

& Assets HE <l a

Iab,motorm + Bind Sensor
e B et oot

lab_motor Specifications Alarm Threshold
in temperature

Asset N icalit Departmen

lab_motor High Test
Warning 40.00°C Alarm 50.00°C
sset Model sset Type Rotate speed
QW-10 Motor 600 RPM o '
; Group ible

Power DE bearin Line Frequenc
300 kW 11 Hz Warning 7.1mm/s Alarm 11mm/s
Ni Itag G

-V A

Figure 54: Asset Detail View Map

2. Click the "Edit" icon next to Asset Location.
3. Drag and drop the asset pin to the correct position or select a predefined zone from the
dropdown list.

Asset Location X

Location*

‘ Singapore-ATS / lab / level16

Move icon on the map to indicate asset's location.

g
&)

‘ Cancel ‘ Save

Figure 55: Asset Detail Edit Location

4. Click "Save" to update the location.
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6.6 Asset Detail View

Click on any asset from the listing to open its Asset Detail View. This page includes

configuration settings, sensor assignments, and performance metrics.

&TDK
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lab_motor ‘ W View Map

08 Dashboard

&TDK & Assets | NS
TDK SensEI SRR —
MAIN MENU

Status B Event B Log
A sensors
lab_motor Specifications 2 Alarm Threshold “
(©) Gateways
sset Name Criticality Departme; Skin temperature
O Notifications lab_motor High Test
Warning 40.00°C Alarm 50.00°C
SETTINGS Asset Model sset Type Rotate speed
QW-10 Motor 600 RPM ) )
1SO standard: 1SO10816-3/Group 1/Flexible
2 Manage Users Powe DE bearing Line Frequency
300 kKW 1 Hz Warning 7.1mm/s Alarm 1mm/s
P Manage Roles Num of poles ltage Current
- -V -A
®© Manage Locations
& Manage Asset DB
ekinngor [
ULUATCustom1  ©
All Sensors =
edge@ by ToK Senset
ensor Name ensor D taty: Classification SensorTvpe nsor Mode Position Gateway Last Updated On
Figure 56: Asset Detail View
6.6.1 Overview Tab
Displays:
e Asset Specifications
e Linked Sensor Information
All Sensors ‘ & |
Sensor Name Sensor ID Status Classification Sensor Type Sensor Mode Position Gateway Last Updated On
lab_motor 1 34dac1200a23 = Offline Lyng KPI/Raw Data/- Top SG_lab1 2026-02-13 05:25:40
lab_motor 2 34dac1 200094 * Offline Lyng KPL/Raw Data/- black SG_lab1 2026-02-13 05:25:53
Lab_motor_3 34dac120018a * Offline Lyng KPI/Raw Data/-- 3 SG_lab1 2026-02-13 05:25:58
lab_motor 4 34dac1 200860 = Offline Lyng KPI/Raw Data/- side SG_lab1 2026-02-13 05:19:07
| 1 ‘ ‘ 10/ page

Figure 57: Asset Detail Linked Sensors

e Threshold Settings
e Location (View Map)
e Model Details
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6.6.2 Status Tab

Displays:
e Sensor trend data for vibration and temperature over time
e Visualindicators for anomalies and performance degradation

HEU\ ‘

Map ‘ -+ Bind Sensor

lab_motor |

& Assets € ‘ a

B overview @ status B3 Event B Log
34dac1200a23 (lab_motor_1) ‘
Top(34dac1200a23) | 1 Week 1 Month 3 Months 2026-02-03 2026-02-03
-@- Axial @~ Horizontal Vertical

o} T T T v T T
2026-02-03 00:0:53 2026-02-03 02:00:00 2026-02-03 04:00:00 2026-02-03 06:00:00 2026-02-03 08:00:00 2026-02-03 10:00:00 2026-02-03 12:00:00 2026-02-03 14:23:53

1 1

Figure 58: Asset Status Trend
6.6.3 Event Tab
Provides:

e Achronological record of sensor and asset-related actions

< Assets

st “ Hd
Q ‘ n‘ Alarm H Warning H ] ‘

== [c] »

B overview

Status Source Sensor Event Reported On Updated On Count User
®Warning lab_motor 34dac1200a23 Skin temperature exceed warning threshold 2026-01-13 14:27:16 - 1
Karan.She
® Closed lab_motor 34dac1200b94 Skin temperature exceed alarm threshold 2026-01-13 14:36:54 2026-01-13 14:37:24 1 i
i
Karan.She
@ Closed lab_moter 34dac1200094 Skin temperature exceed alarm threshold 2026-01-13 14:37:54 2026-01-13 14:52:34 1 "
i
>

Figure 59: Asset Detail Event
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6.6.4 Asset Logs Tab

Shows:
e Installation and removal records
e Historical changes such as binding, unbinding, and coordinate updates

& Assets | Hgm HE o

lab_motor | view nap
B overview ‘ @ Status B3 Event Log

Item Event User Updated On

1 Unbound the senser "200909" ekin.ngor 2026-03-04 17:23:19

2 Machine status changed from normal to offline 2026-02-06 14:57:12

3 Machine status changed from offline to normal 2026-02-06 14:53:03

4 Bound the sensor "200909" ekin.ngor 2026-02-06 14:52:58

5 Bound the sensor "123456" ekin.ngor 2026-02-06 14:50:12

6 Machine status changed from normal to offline 2026-02-06 14:48:32

7 Machine status changed from offline to normal 2026-02-06 14:47:03

8 Bound the sensor "200909" ekin.ngor 2026-02-06 14:46:09

9 Machine status changed from normal to offline 2026-02-06 14:38:47

2 s 4 > torpage v

Figure 60: Asset Detail Logs
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7. Machine Learning in edgeRX™

7.1 ML Information Overview

The edgeRX™ Platform leverages Edge Al to process data locally at the source. Machine
Learning models analyze sensor data to detect anomalies and classify asset conditions in

real-time.

ML Information is displayed in the Sensor Detail View > Overview Tab (see Section 5.5.1).

&TDK =

< All Facili
TDK SensEl Sensors acility
MR M) 34dac12004be

88 Dashboard
D C I Machine Learning Insights
ssets
r Sensors . =
Historical Trends

ML Inference

) Gateways

8O nNotifications Inference Results

SETTINGS
Class Probabilities

2, Manage Users

lust 0 Class Labels Probability

B0 Manage Roles cluster_
luster_0 1.00

@© Manage Locations

Anomaly Score at 2025-12-30 23:45:31: 0.09
& Manage Asset DB

D user Logs

sam
Administrator

edge@ iy oK semstr

Real-time Anomaly Scores

Figure 61: Sensor Machine Learning

7.2 ML Model Types

The edgeRX™ system supports various ML model types optimized for different asset

monitoring scenarios. The specific model type deployed to each sensor depends on:

e Assettype
e Monitoring requirements
e Historical performance data

7.3 Class Labels and Score Thresholds
Class Labels

Class labels represent different operational states of monitored assets, such as:
e Normal Operation
e Degradation
e Fault Conditions
e Specific Failure Modes

&TDK
TDK SensEI
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Score Thresholds

Score thresholds determine when alerts are triggered:
Threshold Type Description
Warning Indicates potential degradation; requires monitoring

Alarm Indicates critical condition; requires immediate attention

Administrators can configure these thresholds in the ML Information section of each sensor.
Notifications will not be sent if the scores fall under the threshold.
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8. Viewing Al Inference Results
8.1 ML Insights Tab

The Machine Learning (ML) Insights tab enables you to view Al-based classifications and
anomaly scores of the sensor, allowing you to assess the operational status of the asset and

detect abnormal conditions in real-time.

To access: Navigate to Sensor Detail View > ML Insights Tab.

 Sensors
2000d8

B overview liI\ Machine Learning Insights P Data Record | Live View
ML Inference Historical Trends ML Model Deployment ML Pipeline Logs

Inference Results

Confirm or correct the resule 1 & Class Probabilities

Class Lakels

Mormal - Low Speed
Anomaly

Mormal - Medium Speed

Anomaly Score at 18-08-25 11:04:12: 0.55
Mormal - High Speed

Start Live Inference

= OEy L iz
& Diagnostics gﬂ History
Prabability
85.0
1.0
3.0%

Figure 62: Sensor ML Class

8.2 ML Inference Tab
The ML Inference tab displays:

e Inference results
e Class probabilities
e Real-time Anomaly scores

8.3 Start/Stop Live Inference

Starting Live Inference

1. Click "Start Live Inference".
2. Click "Confirm" to start collecting data in real-time.
3. Clicking "Cancel" will stop the live inference action.
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Live Inference X

Starting Live Inference will reduce the battery life

Figure 63: ML Live Inference Confirmation

STDK M
TDK SensEl [ € Sensors Al Facility =
M 34dac12004be

88 Dashboard
& K B Overview [N Machine Learning Insights Y Data Record I£  Live View 2 Diagnostics 3] History
Ssets

ML Inference Historical Trends

@) Gateways

& Wotifications Inference Results
SETTINGS
Class Probabilities
& Manage Users
Class Labels Probability
& cluster 0
FPo Manage Roles =2
cluster 0 1.00

© Manage Locations

Anomaly Score at 2025-12-30 23:45:31: 0.09
& Manage Asset DB

O user Logs Stop Live Inference

2 Y Real-time Anomaly Scores
Administrator =
layed

Figure 64: Sensor ML Live Inference

Stopping Live Inference

Clicking "Stop Live Inference" before the predefined 10-minute timer ends will terminate the
action and stop collecting live inference data.

Viewing Real-Time Data

The user can view:
e Real-Time Anomaly scores
e Real-Time Anomaly Trend Chart of most recent 3 hours
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STDK @D ¢ Sensors Ean & QO

MAIN MENL

2000d8
B8 Dashboard

© Assets E:E Overview I\ Machine Learning Insights m Data Record @ Live View KQ Diagnostics a History

ML Inference Historical Trends ML Model Deployment ML Pipeline Logs

() Gateways

Inference Results
L Notifications

1® Logs Confirm or correct the result 15 o Class Probabilities
SETTINGS Class Labels Probability
2, Manage Users @ Normal- Low Speed 85.09
A 0%
Anomaly
F5 Manage Rales
@ Normal - Medium Speed 12.0%
& Manage Assel DB
Anomaly Score at 18-08-25 11:04:12: 0.55
MNormal - High Speed 3.0%
Stop Live Inference 08:04:12
Real-time Anomaly Scores & Hours 24 Hours 2025-06-08 - 20250508 &
- Anomaly

Maria Herrman [
Admin 0.25

18:03:35 19:04:05

Bdge@ by TOK Sensel 2025-05-27 - 2025-06-03 l l 2025.05-27 - 2025-06-03

Figure 65: ML Real Time Chart
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8.4 Historical Trends Analysis

The Historical Trends tab displays trend analysis of the sensors. Users can see:
e Median Score
e Anomaly Rate
e MaxAnomaly Score

< Sensors BN v G| a
2000d8
@ Overview liIN Machine Learning Insights Data Record | Live View ¥ Diagnostics 5} History
ML Inference Historical Trends ML Model Deployment ML Pipeline Logs
Historical Trends Analysis 8 Hours | 24 Hours 2025-06-08 - 2025-05-08 O
Median Score Anomalies Detected Anomaly Rate Max Anomaly Score

Anomaly Score Trend

2025-05-28 - 20250529 3
- Anomaly

1.10 B 2025-05-28 - 2025-05-29

19:03:35 19:04:05 19:04:35 19:05.05 19:05:35 19:06:05

202505-27 - 2025-06-03 ' ' 2025-05-27 - 20250603

Figure 66: ML Historical Trends
Time Range Selection

Toggle between predefined time ranges:

e 3hours
e 8hours
e 24 hours

Alternatively, use the date range picker to observe datain:
e Anomaly Score Trend charts
e Class Probability Trends charts
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9. Data & Monitoring
9.1 Data Records

&TDK

TDK SensEI

Navigate to Sensor Detail View > Data Record Tab to view performance trends and raw

signal values.
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< Sensor

MAIN MENU Lynq | 34dac1200860

98 Dashboard

(== [s]

@ Assets B overview ‘ I\ Machine Learning Insights Data Record & Live View & Diagnostics &) History
(©) Gateways ‘ M‘ @‘ ‘ 1 Week 3 Months ‘ 2026-01-01 2026-01-22 ‘
L Notifications
Figure 67: Sensor Data Records
9.1.1 KPI Trend
The KPI Trend tab includes two sub-tabs:

4 Sensor HEEN HU‘ a
Lynq | 34dac1200860 m
B Overview ‘ i\ Machine Learning Insights Data Record I Live View ‘ & Diagnostics ‘ &) History
Raw Data | 1 Week | 1Month | 3Months || 2026-01-01 2026-01-30

1S0/Temp Acceleration

Velocity RMS (mm/s)
2026-01-01 - 2026-01-30 4

-@ Axial  —@~ Horizonta — Vertical

0 T T T y T r
2026-01-13 14:48:45 2026-01-13 180000  2026-01-13 20:00:00  2026-01-13 22:00:00  2026-01-1400:00:00  2026-01-14 02:00:00  2026-01-14 04:00:00

2026-01-14 06:00:00

2026-01-14 08:00:00  2026-01-14 00:48:45

Figure 68: Sensor KPI Trend

ISO/Temp Sub-tab

View:
e \elocity RMS
e Rotating Speed
e Skin Temperature
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Acceleration Sub-tab

View:
e Acceleration Peak
e Acceleration RMS
e CrestFactor

&TDK
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1SO/Temp Acceleration

Acceleration Peak (g)
2026-01-01 - 2026-01-22 [4

—@- Avisl  —@— Horizontal @ Vertical

0
2026-01-13 14:48:45 2026-01-13 18:00:00  2026-01-13 20:00:00  2026-01-13 22:00:00 ~ 2026-01-14 00:00:00  2026-01-1402:00:00  2026-01-1404:00:00  2026-01-14 06:00:00

2026-01-14 08:00:00  2026-01-14 09:48:45

Figure 69: Sensor Acceleration Chart

Time Range Selection:

o Toggle between 1 Week, 1 Month, 3 Months
e Alternatively, use the custom date picker

9.1.2 Raw Data

The Raw Data tab includes two sub-tabs: Velocity and Acceleration.

&TDK € Sensors Al Facility

TDK SensEl

MAIN MENU
B overview I\ Machine Learning Insights B Data Record £ Live View B Diagnostics
98 Dashboard
N @ View All Records [ aseline jonth whs | 20251231

@ Assets

) Gateways

SETTINGS
& Manage Users

2o Manage Roles Velocity  Acceleration

@ Manage Locations.
& Manage Asset DB Velocity

0 userLogs

5 )

i

o

I

o0s |

|

o

sam [ i
Administrator

2

gdgs@m ‘‘‘‘‘‘‘

.

i}

2026-01-07

o warcwons 1<) DN O O EOTA 0 0T L ML)

Save as Baseline

A g

Figure 70: Sensor Raw Data

Use the "View Baseline" button to show only records marked as baselines.
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&TDK =
- Al Facil = G

TDK SensEl 0 SEnsors s :
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88 Dashboard
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i P .
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Administrator
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Figure 71: Sensor View Baseline

Velocity Sub-tab
View:
e \elocity Chart
o Data table containing velocity details
e Velocity Spectrum Chart
e Peak Frequencies
e Harmonic Frequencies

&TDK - — —
Toksenset L € Sensors Al Facility = G| a
M 34dac12004be

98 Dashboard
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servs 1< 0 A RO U Oy >

12 00:00 01-03 00:00 01-04 00:00 01-05 00:00 01-06 00:00 01-07 00:00

2 Manage Users
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Lo Manage Roles -
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& Manage Asset DB
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0
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015
sam rs &
Administrator -

Figure 72: Sensor Raw Data Velocity
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Figure 73: Sensor Raw Data Velocity Spectrum
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Figure 74: Sensor Raw Data Peak and Harmonic Frequencies

Acceleration Sub-tab

View:

e Acceleration Chart
o Data table with Acceleration details

e Acceleration Envelope Spectrum Chart
e Peak Frequencies
e Envelope Analysis results chart
e Bearing Frequencies
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Figure 76: Sensor Raw Data Acceleration Spectrum
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Figure 77: Sensor Raw Data Envelop Analysis
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Figure 78: Sensor Raw Data Bearing Frequencies
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9.1.3 Exporting Data

Each chartincludes an "Export" button to download data in CSV format.

To export:
1. Navigate to the desired chart (KPI Trend or Raw Data).
2. Click the "Export" button.
3. The data will be downloaded as a CSV file.

ISO/Temp Acceleration

Acceleration Peak (qg)

- - a a T ol e - A
'V AE-017 =00 N:26-0) ]
LU L2010 ’ FAlFAallY £

Figure 79: Graph Export Button

9.2 ISO-Based Results

ISO standards provide vibration thresholds for machinery condition monitoring.

9.2.1 Understanding ISO Standards

ISO vibration standards define acceptable vibration levels for rotating machinery based on:

e Machine type
e Operating speed
e Mounting configuration

9.2.2 Viewing ISO Results

ISO-based results are displayed in the KPI Trend > ISO/Temp sub-tab (see Section 9.1.1).

The system compares measured vibration levels against configured ISO thresholds to
determine asset health status

9.2.3 Configuring ISO Standards

For information on configuring ISO standards and thresholds, see Section 11.4.
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9.3 Live View

Navigate to Sensor Detail View > Live View Tab to monitor real-time acceleration waveforms
across vertical, axial, and horizontal axes. Connection status is displayed in real time.

&TDK O & Sensors All Facility

TDK SensEl

BRI MERY 34dac12004be

88 Dashboard

B overview [N Machine Learning Insights ) Data Record = Live View & Diagnostics &) History
Assets

@
)v Live View
(=) Gateways Data Source QDR Acceleration Range

SETTINGS

& Manage Users

Status e Disconnected Duration(s) 179 Select saved record + Add Chart
> Manage Roles & i

Measuring Duration: 00:00:00, Packet Loss Rate: 0.0

o

@

Manage Locations
& Manage Asset DB

D user Logs

Acceleration Time Waveform

0. o
Administrator -
Velocity Spectrum togscale (I & & @ LU 1iarmonic
Edgg@ —

Figure 80: Sensor Live View

Adding Charts

To add a new chart:
1. Click "Add Chart".
2. Configure chart parameters:

Parameter Description

Chart type Select visualization type
Band pass filter Configure frequency filtering
Frame Size Set data frame size

FFT window type Select FFT window function
Number of average Set averaging samples
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Add Chart

Chart type*

Please Select

Band pass filter*

Please Select

Frame Size* Spectrum resolution

‘ Please Select

FFT window type* Overlap Ratio*

[ Prease setect
|

Number of Average* Time slot period

‘ Please Select

||
| |

Figure 81: Live View Add Chart

3. Click "Confirm" to add the chart.
4. Clicking "Cancel" will terminate the action and the chart will not be added.
/\ Note: Multiple charts can be added for comparative analysis.
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10. Notifications & Alerts
10.1 Notification Types

Log into the edgeRX™ Platform using your authorised credentials, then navigate to
Notifications page.

STDK [ Notifications ‘ ‘ =N ‘ ‘E‘ a

TDK SensEI

MAIN MENU ——
D Asset @ 3 pevice @ ‘ 3 set Notification

03 Dashboard -

@ Assets ‘ Q ‘n‘ Alarm H Warning ‘ S o] ‘ @ ‘

Ar Sensors

(] status Source Sensor Event Reported On Updated On Count Actions
(©) Gateways

L Notifications . (O | eClosed lab_motor 34dac1200b94 Skin temperature exceed alarm threshold 2026-01-13 14:37:54 2026-01-13 14:52:34 1 ‘ jof ‘

SETTINGS

O [ eclosed lab_motor 34dac1 200694 Skin temperature exceed alarm threshold 2026-01-13 14:36:54 2026-01-13 14:37:24 1 ‘ o] ‘
2 Manage Users S
Lo Manage Roles .
O [ eWarning lab_motor 34dac1200a23 Skin temperature exceed warning threshold 2026-01-13 14:27:16 2026-01-13 14:27:16 1 ] ‘ o] ‘
®© Manage Locations
‘ 1 ‘ ‘ 10/ page ‘

& Manage Asset DB

Figure 82: Notifications Tab
The Notifications page has two tabs:

10.1.1 Asset Tab

View the list of alarm, warning, and ML notifications from assets.

Search Capabilities:

e Source
e Sensor
e Event

10.1.2 Device Tab

View the list of notifications from Sensors & Gateways regarding offline/online status.

Search Capabilities:
e DevicelD
e Event
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MAIN MENU

Notifications

Hgm G

D Asset @ 2 pevice ® §83 set Notification
98 Dashboard
@ Assets Q n Alarm Warning 5 || @ || @
A Sensors
() status Device ID Device Type Event Reported On Updated On Count Actions
(©) Gateways
L Notifications . Alarm 34dacib1011c GW2201D Gateway is offline! 2026-01-13 14:48:05 2026-02-19 16:44:05 3 o] ‘
SETTINGS
O [eaarm 34dacib1011c GW2201D Gateway cpu exceed alarm threshold 2026-02-19 16:37:05 2026-02-19 16:37:05 1 jof ‘
2 Manage Users
Lo Manage Roles —
o Alarm 34dac1200909 Lyng €n2202b 3.0 is offline! 2026-02-06 14:57:05 2026-02-06 14:57:05 1 B @ ‘
®© Manage Locations
& Manage Asset DB O [eaarm 34dac1200909 Lynq €n2202b 3.0 is offline! 2026-02-03 14:56:05 2026-02-03 15:12:05 2 o] ‘
Alarm 34dac1200a23 Lynq €n2202b 3.0 is offline! 2026-01-13 14:48:05 2026-01-13 14:48:05 1 o] ‘
o Alarm 34dac1 200094 Lynq €n2202b 3.0 is offline! 2026-01-13 14:48:05 2026-01-13 14:48:05 1 o] ‘
o ekin.ngor 53 » ® Alarm 34dac120018a Lynq €n2202b 3.0 is offline! 2026-01-13 14:48:05 2026-01-13 14:48:05 1 o) ‘
ULUATCustom1
{ J 10/ page

edgeggsmmn

Figure 83: Notifications Tab Device

10.2 Managing Notifications

10.2.1 Acknowledge a Notification

1. Click the "Acknowledge" (handshake) icon.

2. Add acommentin the field provided (optional).
3. Click "Confirm" to acknowledge the notification.
4. Clicking "Cancel" terminates the action.

m ‘ Alarm ‘ ‘ Warning ‘ 1]
ed On Count Actions

2-19 16:44:05 3 E E
2-19 16:37:05 1 E E
2-06 14:57:05 1 E E

Figure 84: Acknowledge Icon
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Acknowledge Alarm X

Comment*

‘ Cancel H

Figure 85: Acknowledging Alarm Modal

10.2.2 Delete a Notification

1. Click the "Delete" (trash) icon.
2. Click "Confirm" to delete the notification.
3. Clicking "Cancel" will stop the action and the notification will not be deleted.

m ‘ Alarm ‘ ‘ Warning ‘ & 0]
ed On Count Actions

2-19 16:44:05 3 E E
2-19 16:37:05 1 E E
2-06 14:57:05 1 g E

Figure 86: Delete Icon

Delete Notification %

Are you sure you want to delete the selected notification(s)?

B -

Figure 87: Deleting Alert Modal

10.2.3 Bulk Actions

To acknowledge or delete notifications in bulk:
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1. Select multiple notifications using the checkboxes.
2. Click the "Acknowledge" or "Delete" icons on the top right.
3. The count of selected notifications is shown as badges on the icons.

Notifications ‘ | =N | ‘E| Ja

- OmO —
Q ‘m‘ Alarm H Warning ‘ ] “ & ‘

@ status Device ID Device Type Event Reported On Updated On Count Actions

o Alarm 34dac1b1011c GW2201D Gateway is offline! 2026-01-13 14:48:05 2026-02-19 16:44:05 3 ‘E‘
o Alarm 34dac1b1011c GW2201D Gateway cpu exceed alarm threshold 2026-02-19 16:37:05 2026-02-19 16:37:05 1 ‘E‘
*Alarm 34dac1200909 Lyng €n2202b 3.0 s offline! 2026-02-06 14:57:05 2026-02-06 14:57:05 1 ‘E‘
*Alarm 34dac1200909 Lyng cn2202b 3.0 s offline! 2026-02-03 14:56:05 2026-02-03 15:12:05 2 ‘E‘

Figure 88: Batch Selection

10.3 Notification Filters

Notifications can be toggled between the following filters:
e All-Show all notifications
e Alarm -Show only alarm notifications
e Warning — Show only warning notifications

Notifications Hgm\. HE| -

| Qa H All H Alarm ‘m & || & ‘@‘

(0  status Source Sensor Event Reported On Updated On Count Actions
() | ewarning lab_motor 34dac1200a23 Skin temperature exceed warning threshold 2026-01-1314:27:16 2026-01-13 14:27:16 1 | ] |
‘ 1 | ‘ 10/ page ‘

Figure 89: Filter Selection

10.4 Email & Mobile Push Notifications

To receive notifications via email or mobile push:
1. Click the "Manage Notifications" button.
2. Enable the desired toggles:
e AssetAlarm
e Asset Warning
e Device Offline
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&TDK ) potifications Al Facility s || G I a)
TDK SensEl | | |
MAIN MENU
88 Dashboard
© Assets Q m Alarm ‘ Warning ||l @ ‘ 8
A sensors

(] Status Source Sensor Event Reported On % Updated On 2 Count  Actions
(=) Gateways

) [emam Asset 1 34dac12000..  Skin temperature exceed alarm threshold 20260106 14:36:11 2026-01-06 14:36:11 1
SETTINGS

3 ® Closed Asset 1 34dac12000... Skin temperature exceed alarm threshold 2026-01-04 22:34:07 2026-01-06 14:35:59 1
A Manage Users
o,
Po Manage Roles » Closed Test Gen-set 34dac12004..  Skintemperature exceed warning thres... 2025-12-31 14:25:00 2026-01-04 23:10:42 2
® Manage Locations
& Manage Asset DB * Alarm Asset 1 34dac12000... Velocity RMS exceed alarm threshold 2026-01-04 22:45:47 2026-01-04 22:45:47 1
0 userLogs

() | #Warning Asset 1 34dac12000..  Skin temperature exceed warning thres..  2026-01-04 22:25:38 2026-01-04 22:25:38 1

&  Closed Asset 1 34dac12000... Skin temperature exceed warning thres... 2026-01-04 22:23:07 2026-01-04 22:24:47 1

sam
2 3 4 5 > | 10/page
adga@ by O Semstl

Figure 90: Manage Notifications Entry Point

Manage Notification

Notifications
Alert Type

Asset alarm @
Assetwarning ©

Device offiine @

Figure 91: Manage Notifications Modal

Notifications will be sent to your registered email address and/or mobile device.
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10.5 Setting Warning/Alarm Thresholds

The "Set Notification" button allows users to set Warning and Alarm Thresholds for
parameters of Sensors and Gateways.

To configure thresholds:
1. Click "Set Notification".
2. Select the device (Sensor or Gateway).
3. Configure the threshold values for relevant parameters.
4. Click "Save" to apply changes.

Notifications Hgm HE| 8

| Q ‘m‘ Alarm H Warning ‘ B || @ ‘(ojz‘

\:\ Status Source Sensor Event Reported On Updated On Count Actions

\:\ ® Closed lab_motor 34dac1200b94 Skin temperature exceed alarm threshold 2026-01-13 14:37:54. 2026-01-13 14:52:34 1 ‘E‘

\:\ ® Closed lab_motor 34dac1200b94 Skin temperature exceed alarm threshold 2026-01-13 14:36:54 2026-01-13 14:37:24 1 ‘E‘

O [ewarning lab_motor 34dac1200a23 Skin temperature exceed warning threshold 2026-01-13 14:27:16 2026-01-13 14:27:16 1 ‘E‘
|Z‘ | 10/ page

Figure 92: Set Notifications Entry Point

Set Notification X

Sensor Configuration applicable only for Lyng

No Parameter Warning threshold Alarm threshold Action Enable

1 Battery Voltage 2.8V 2.4V [ @)

2 RSSI -75dBm -80dBm " @)
Gateways

No Parameter Warning threshold Alarm threshold Action Enable

1 CPU Usage 80% 90% [ @)

2 RAM Usage 80% 90% [ @)

Figure 93: Set Notifications Modal

67



&TDK

TDK SensEI

10.6 Notification Table Features

The Notifications table provides a searchable, paginated view of all notifications.

Feature
Search Bar
Rows per Page

Column Settings

Description
Find notifications from Assets and Devices
Adjust display (dropdown in bottom right corner)

Customize visible columns (Gear option on top right corner)

Notifications

© asset @

|

Q n Alarm Warning i f b

® Closed lab_mator 34dac1200b94

® Closed lab_motor 34dac1200b94

lab_motor 34dac1200a23

Column Display Reset

Status
Skin temperature exceed alarm threshold 2026-01-13 14:37:54 2026-01-13 14:52:34 Source
Sensor
Event
Skin temperature exceed alarm threshold 2026-01-13 14:36:54 2026-01-13 14:37:24 Reported .
Updated .
Count

Skin temperature exceed warning threshold 2026-01-13 1427:16 2026-01-13 14:27:16
Actions

i 10/ page

Figure 94: Notifications Column Display
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11. Configuring Settings

Log into the edgeRX™ Platform using your authorized credentials, then navigate to Settings to
manage system-wide configurations including location hierarchy, asset specifications, fault
databases, and ISO standards.

SETTINGS
2  Manage Users

Lo Manage Roles
Q] Manage Locations

& Manage Asset DB

|_|-_°I User Logs

Figure 95: Menu Bar

11.1 Location Hierarchy

Navigate to Settings > Manage Locations to view the hierarchical layout of Sites, Buildings,
Floors, and Rooms.

&TDK 1] manage Locations Al Facility =N H &l Q
TDK SensEl
MAIN MENU
08 Dashboard O sites B Buildings + B Floors + B Rooms
1 X ettt S ettt
Ekin Lab
A Sensors
No Buildings . No Floors . No Rooms

(©) Gateways
O Notifications |
SETTINGS

& Manage Users

2 Manage Roles

®© Manage Locations ®

& Manage Asset DB

(® User Logs

Ekin-admin (3
Administrator
edge@mm“ﬂ

Figure 96: Manage Locations
Hierarchy Structure:
Site > Building > Floor » Room
Boxes labelled with names will be visible on the screen.

11.1.1 Adding a Site

1. Click "Add" to create a new site.
2. Enter the following details:
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Field

Site Name

Site Map

Description

Name of the site

Upload a site map image
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&TDK

[[J  Manage Locations
TDK SensEl 9
MAIN MENU
93 Dashboard @ sites
@ Assets
Ekin Lab
A+ Sensors

@) Gateways

L Notifications
SETTINGS

& Manage Users

Lo Manage Roles

© Manage Locations e

& Manage Asset DB

©® UserLogs

Ekin-admin
Administrator G

o
adga@ S

+ Add

Buildings

No Buildings

Floors

No Floors

Al Facility ‘

No Rooms

Figure 97: Add Site
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Add New Site

X

Name*

>

‘ Office

Site Map * ® + Upload Please mark points AB on the map

ol[s)islallr +]

Actual Distance (meter)* Scale (m/px)*

‘ 20.000 ‘ ‘ ‘

Original point (meter)

v
‘ | | Reset

|
4 »

‘ Cancel

Figure 98: Add Site Modal

3. Click on 2 separate points to mark Aand B
4. Enterthe Actual Distance in meters.
5. Click "Save" to add the Site.

11.1.2 Managing Existing Locations

Use the following controls to manage Sites, Buildings, Floors, and Rooms:

Control

Edit

Delete

Preview

Reorder

Action

Click the "Edit" icon, update Name/Image/Actual Distance, click "Save"

Click the "Delete" icon and confirm the action

Click the "Preview" (eye) icon to view location on map

Use "Up" and "Down" arrow controls

/\ Note: These controls behave the same for Sites, Buildings, Floors, and Rooms.
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Office v @® B W ‘

Lab

Figure 99: Site Controls

Edit Site X
r 'S
Office
Site Map * ® Please mark points AB on the map
+
K El i 4 ) L = Ay [
A /S ? ' '_ Iﬁ" .: 3w F :.
€y 4 e
4 ., ! 1 E l - :
& X w000 L
A - -
@ e - L 13- ™
Actual Distance (meter)* Scale (m/px)*
‘ 20.000 ‘ ‘ ‘
Original point (meter)
‘ ‘ ‘ Reset ‘ v
4 G >
‘ Cancel ‘ ‘ ‘
Figure 100: Edit Site Map
Delete Site %

This action is irreversible. Do you confirm to delete this Office?

| Cancel ‘ Confirm

Figure 101: Delete Site Modal
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View Site X
MName: Office
ﬂ
O]
Figure 102: Preview Site

11.1.3 Adding a Building

1. Click "Add" button in the Buildings box.

2. Enter the Building Name.

3. Click on the image to generate at least 3 points.

4. Click "Save" to add the Building.

Add New Building %

Building Name*

Office A

Building Map *

+

EIN

Figure 103: Add Building Modal
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11.1.4 Adding a Floor

1. Click "Add" button in the Floors box.
Enter the Floor Name.

Upload a Site Map.

Click "Save" to add a Floor.

Click on 2 separate points to mark A and B
Enter the Actual Distance in meters.

ok wd

Add New Floor

X

»

‘ Operations

Site Map * (@ + Upload Please mark points AB on the map

o [ =

1 : -
L EEEEE

EISENCIE

Actual Distance [meter)* Scale (m/px)*

‘ 10.000 ‘ ‘ ‘

Original point (meter)

‘ ‘ ‘ Reset
B (

v
»

Cancel

Figure 104: Add Floor Modal

11.1.5 Adding a Room

1. Click "Add" button in the Rooms box.

2. Enter Room Name and Room Color.

3. Click on the image to generate at least 3 points.
4. Click "Save" to add a Room.
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Add New Room X
Room Name* Room Color*
Boardroom B Green

R
i

Figure 105: Add Room Modal

11.1.6 Map Toolbar

Use the Map Toolbar to interactively manage the layout:
e Zoom -Zoom infout of the map
e Reset-Reset map to default view
e Scaling (AB points) — Set scale reference points
e Origin adjustment — Adjust map origin
e Layout reset — Reset layout to default

11.2 Manage Asset DB / Asset Types

Navigate to Settings > Manage Asset DB > Asset type to view and configure asset types.

ATDK

N}
DSerae Asset Database

]

MAIN MENU

08 Dashbeard ng D ndar @ Asset Type
pssets
Specifications 1 ult Diagnosi

+ Add Custom Field

RPM

Figure 106: Manage Asset Type

11.2.1 Adding a Custom Field

1. Click the "+ Add Custom Field" button.
2. Enter the following details:
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Field Description
Field Name Name of the custom field
Field Type Data type (text, number, etc.)

Unit Unit of measurement (if applicable)

Add Custom Field %

Field Name*

Field Type*®

‘ Number ‘

Unit

‘ Cancel H ‘

Figure 107: Custom Field
3. Click "Add" to create the custom field.

11.2.2 Adding an Asset Model

1. Click "Add Model" to input specifications for a selected asset type.
2. Enter the following:

Field Description
Asset Model Name Name of the model

Rotate Speed (RPM) Rotational speed in RPM

DE Bearing Drive-end bearing specification
Num of Impeller Number of impellers

Voltage (V) Operating voltage

Current (A) Operating current
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Asset Database ‘ Al Facility HE EN Hg‘ o
Specifications Model Fault Diagnosis
Asset Type

B ump Compressor Fan Generato Bearing base cearbox sevave | spnae |

Asset Model + Add Model ‘ @ |

Asset Model Updated On User Actions

QE-10 2026-03-03 19:05:16 Ekin-admin

o]

Figure 108: Asset DB Asset Type

Add Model X
Asset Model Name*

Rotate speed (RPM)

Power (kW)

DE bearing*

‘ Select the DE bearing ‘

Line Frequency (Hz)
Num of poles
Voltage (V)

Current (A) v

‘ Cancel ‘ ‘ ‘

Figure 109: Add Asset Modal
3. Click "Confirm" to add the Model.

11.2.3 Managing Asset Models

You can view all models under each type and use the Edit or Delete links to manage them.
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Sensor location values can also be added, edited, or deleted dynamically to define exact
placement points.

11.3 Bearing DB

Navigate to Settings > Bearing DB to view, add, edit, or delete fault entries.

TDK SensEl

MAIN MENU
98 Dashboard

Q@ Assets

() Gateways
L Notifications
SETTINGS

& Manage Users.

Qo Manage Roles

©® Manage Locations

(O user Logs

AN
&TDK ] asset Database

‘ All Facility HE EN H (€ ‘ A\
@ Bearing DB @ 150 standard @ Asset Type
Bearing Fault Database & Import ‘ o + Add ‘ &

) Bearing type Number of balls FTF_60RPM BSF_60RPM BPFO_60RPM BPFI_60RPM Actions

] N206 12 0419 2988 5.023 6.977 ‘ o ‘
) 9 0402 2.461 3621 5379 ‘ o ‘
] N214 16 0433 3683 6.933 9.067 ‘ o ‘
] N210 15 0429 3.429 6.429 8571 ‘ o ‘

11.3.1 Adding Bearing Fault Data

1. Click "Add" to input new bearing fault frequency.
2. Enter the following:

Field

Bearing type
Number of balls
FTF_60RPM
BSF_60RPM
BPFO_60RPM

BPFI_60RPM

Description

Type/model of bearing

Figure 110: Asset DB Bearing

Number of rolling elements

Fundamental Train Frequency at 60 RPM

Ball Spin Frequency at 60 RPM

Ball Pass Frequency Outer race at 60 RPM

Ball Pass Frequency Inner race at 60 RPM
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3.

Add Bearing Fault Frequency

Bearing type*

Number of balls*

FTF_60RPM*

BSF_GORPM*

BPFO_S0RPM*

BPFI_60RPM*

‘ Cancel

Figure 111: Add Bearing Modal

Click "Save" to add the bearing fault data.

11.3.2 Editing Bearing Fault Data

1.
2.
3.
4.

Click the "Edit" icon from the actions column.
Update the fault frequency values.

Click "Confirm" to save changes.

Clicking "Cancel" will terminate the edit action.

11.3.3 Deleting Bearing Fault Data

1.
2.
3.

Click the "Delete" icon from the actions column.
Click "Confirm" to delete the bearing.
Clicking "Cancel" will terminate the delete action.

11.3.4 Bulk Upload Bearing Faults
To bulk upload bearing faults:

1.

2.
3.
4

Click the "Import" button.

Download the template file.

Complete the template offline with your bearing data.
Upload the completed file back into the system.
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Import Bearing List %

1. Download Template

Get the bearing template and fill in your data following the provided
instructions.

&, Download Template

2. Upload the completed file

/‘\

(L]
Click to upload or drag and drop

Supports .xIsx files only (Max: 10MB)

‘ Cancel ‘ ‘

Figure 112: Bearing List Upload

11.4 1SO Standards

Navigate to Settings > ISO Standards to view and configure vibration thresholds.

[Asset Database ‘ Al Facility Hg EN H S ‘ pal

® 150 standard

#3  Bearing DB ® Asset Type

1SO Standard

3 -

150 Standard Description Warning threshold Alarm threshold Actions
15010816-3/Group 1/Rigid 300KW~S0MW,rigid mounted 45 mmss 7.1 mmss
15010816-3/Group 1/Flexible 300KW-S0MW flexible mounted 7.0 mmss 1 mmis
15010816-3/Group 2/Flexible 15KW~300MW, flexible mounted 45 mmss 7.1 mmss
15010816-3/Group 2/Rigid 15KW-300MW,rigid mounted 28 mmss 45 mmss
E] ‘ 10/ page ‘

Figure 113:1SO Standards
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11.4.1 Adding an ISO Standard

1.
2.

3.

Click "Add" to add an ISO standard.
Enter the following:

Field Description

ISO Standard ISO standard name/number

Description Description of the standard

Warning Threshold Vibration level that triggers warning

Alarm Threshold Vibration level that triggers alarm
Add ISO standard X

ISO Standard*
Description*

Warning Threshold (mm/s)*

| mm/s ‘

Alarm Threshold (mm/s)*

| mm/s ‘

‘ Cancel H ‘

Figure 114: ISO Standard Modal

Click "Save" to add the ISO standard.

11.4.2 Editing an ISO Standard

1.
2.
3.
4.

Click the "Edit" icon from the actions column.
Update the standard details.

Click "Confirm" to save the edited changes.
Clicking "Cancel" will terminate the edit action.

11.4.3 Deleting an ISO Standard

1.
2.

Click the "Delete" icon from the actions column.
Click "Confirm" to delete the ISO standard.
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11.5 Fault Diagnosis

Navigate to Settings > Manage Asset DB > Asset Type > Fault Diagnosis to view a list of
predefined fault types for this asset model.
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Asset Database

& Bearing DB

‘ ® 150 standard

‘ Al Facility ‘ ‘ =2 ‘ ‘ (G

Ia\

Specifications Model  Fault Diagnosis
Asset Type
Fault Diagnosis
No. Fault Name Data Type Parameter Description
Imbalance occurs when the mass distribution of a rotating component is not
1 Imbalance SpectraiVelocity RPM uniform, causing it to generate centrifugal forces that lead to excessive
vibration.
Angular misalignment occurs when shaft centerlines intersect at an incorrect
2 Angular misalignment Spectra/Velocity RPM angle, causing axial force vectors and moment loading that accelerate
coupling wear:
Parallel misalignment occurs when shaft centerlines develop offset
3 Parallel misalignment Spectra/Velocity RPM parallelism, causing radial forces proportional to displacement distance that
induce bearing overload
Bearing wear oceurs when rolling elements experience progressive material
4 Rolling bearing wear Spectra/Envelope Bearing type loss, causing characteristic vibration patterns and thermal elevation that

reduce load capacity.

Structural looseness occurs when mechanical joints lose design stiffness,

Figure 115: Fault Diagnosis

This section displays the fault diagnosis categories configured in the system for asset

condition monitoring.
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12. Troubleshooting

This section covers common dashboard-related issues. For hardware troubleshooting, refer to
the respective hardware user manuals (see Section 1.2).

12.1 Sensor Issues

12.1.1 Sensor Appears Offline on Platform

If a sensor shows as offline in the platform:
1. Ensure sensor was turned on by checking the on/off switch found in the sensor.
2. Ensure that the sensor MAC ID was entered successfully when adding the sensor to
the platform.
3. Ensure that the sensor was successfully bound to the gateway and the asset.

Sensors ‘ All Facility ‘ ‘ E N ‘ ‘ €] ‘

| Q|

‘ = Process gueue ‘

| 0

cancar 1D Namaea Tune atawnr=u T Ctatire Bonar
Sensor ID Name Type Gateway ID Status Power

L

01| 34dacta2lc3f Sensor_T1 Lyng 34dacib1011e [ e offline |

lﬂ ‘ 10 / page

Figure 116: Sensor Offline

If the issue persists after these checks, contact your TDK SensEl representative for
assistance.

12.1.2 Sensor LED Indicators

For information about sensor LED indicators and their meanings, please refer to the edgeRX™
LYNQ Sensor User Manual (SE1111101G-01), Section "LED Status & Descriptions."
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12.2 Gateway Issues

12.2.1 Gateway Appears Offline on Platform

If a gateway shows as offline in the platform:

1. Ensure that gateway power supply was attached properly — Check all power
connections.

2. Ensure that gateway was added to a location successfully on the platform.

Gateways | All Facility || = en

e B e

Gateway_1 3d4dacibi0lle - 1 * Offline Lab/Built

[I] 10/ page

Figure 117: Gateway Offline

If the issue persists after these checks, contact your TDK SensEl representative for
assistance.

12.2.2 Gateway LED Indicators

For information about gateway LED indicators and their meanings, please refer to the
edgeRX™ Gateway User Manual (SE5100204G-01), Section "LED Status & Descriptions."

12.3 Platform Issues

12.3.1 No Data Appearing on Platform
If sensor data is not appearing on the platform:
1. Verify that sensors are online (see Section 12.1.1).
2. \Verify that gateways are online (see Section 12.2.1).
3. Check that sensors are properly bound to assets (see Section 6.4).
4. Refresh your browser page.

12.3.2 Widget Appears Inactive or Blank
If widgets on the homepage dashboard appear inactive or blank:
1. Confirm that your gateways and sensors are online.
2. Checkyour network connection.
3. Verify that you have proper permissions to view the data (see Section 3).
4. Try switching to a different location using the location selector (if available).
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12.4 Contacting Support

If any issues persist after following the troubleshooting steps, please contact your local TDK
SensEl representative.

When contacting for support, please provide the following:
e Useraccountinformation
e Description of the issue
e Screenshots (if applicable)
o Steps taken to troubleshoot

85



&TDK
TDK SensEI

Appendix
A. Glossary of Terms

Term Definition
Asset A piece of equipment or machinery being monitored by the edgeRX™ system
edgeRX™ TDK SensEl's end-to-end platform for real-time equipment health monitoring

Gateway Hardware device that collects sensor data and transmits it to the cloud

KPI Key Performance Indicator — measurable values used to evaluate asset health
ML Machine Learning — Al algorithms used to analyze sensor data
MFA Multi-Factor Authentication — security feature requiring multiple verification methods

Sensor Hardware device that collects vibration and temperature data from assets

ISO International Organization for Standardization — defines vibration standards
RSSI Received Signal Strength Indicator — measures wireless signal strength
RPM Revolutions Per Minute - rotational speed measurement

RMS Root Mean Square - statistical measure of vibration magnitude

FFT Fast Fourier Transform — algorithm for frequency analysis
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B. Related Documentation

For complete information about the edgeRX™ system, please refer to the following

documents:
Document Title Model Number
edgeRX™ Gateway User
Manual SE5100204G-01

edgeRX™ LYNQ Sensor User
Manual SE1111101G-01

edgeRX™ Platform User
Guide (this document) -

Description

Hardware setup, installation, network configuration,
LED indicators, physical troubleshooting

Hardware activation, physical installation, battery
information, LED indicators, physical troubleshooting

Software navigation, monitoring, and configuration

These documents can be obtained from your TDK SensEl representative.
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